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Banner 9 Action Item Processing Set Up Checklist 

Introduction 

This checklist provides systematic instructions to set up Banner 9 Action Item Processing for students. 
Action Item Processing provides the user with the ability to create Action Items for which a specific 
population needs to respond.  

The user can schedule when the population will be notified and track the status of the responses. Users 
that have Action Items that require a response before they can proceed with their task will be prompted 
with a notice and redirected to the Action Items page.  

Users can access a list of their assigned Action Items from the General Self-Service landing page. If a 
Banner Self-Service application includes support for Action Items, it will have identified processes that 
can be halted by one or more Action Items. The user will be able to select one or more of those 
processes when defining the Action Item on the Action Item Processing page. 

Prerequisites 

Prerequisites include the following: 

• Thorough review of current release related documentation. 

• Knowledge of Banner functionality related to set up for managing communication. 

Environment Set Up 

Setup should occur first in Banner 9 Communication Management, General Self Service, Web Tailor, 
and Student Registration in test environments. After successful testing functionality, utilize the same 
steps to set up the production environment. 

Ellucian Documentation 

• Application_Navigator_Handbook 

• Banner_Communication_Management_Handbook  

• Banner_General_Self_Service_Handbook  

• Banner_Student_Self_Service_Registration_Handbook 

• Banner Web Tailor User Guide 

More Information and Support 

For emergency, business interruption, or other production down situations, immediately call the ITS 
Helpdesk (706-583-2001 or 888-875-3697 toll-free within Georgia). For non-urgent issues, submit a 
service request at https://usg.service-now.com/usgsp. (Self-service support or service requests require 
a user ID and password; email helpdesk@usg.edu for assistance.) 

 

https://usg.service-now.com/usgsp
mailto:helpdesk@usg.edu
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Resources 

For information about ITS maintenance schedules or Service Level Guidelines, please visit 
http://www.usg.edu/customer_services/service_level_guidelines. For USG services status, please visit 
http://status.usg.edu. 

 

http://www.usg.edu/customer_services/service_level_guidelines
https://status.usg.edu/
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Technical Setup 

Set up Action Item Processing Administrators 

 Set up Role Based security through Banner Web Tailor for the following roles: 

o End user – COMMUNICATIONUSER role 

o Author – COMMUNICATIONCONTENTADMIN role 

o Action Item Processing administrators – ACTIONITEMADMIN role (Web Tailor) 

o Communication administrators – COMMUNICATIONADMIN role (Web Tailor users have 
access to BCM tables) 

 Log in to GSASECR as BANSECR and click the Classes tab. 

 Locate BAN_AIPADMIN_C and click Object. 

 Add the object CMQUERYEXECUTE with role BAN_DEFAULT_M. The role cannot be 
the default of BAN_DEFAULT_CMQUERYEXECUTE_M. 

 Save the changes and click close. 

 Click on Users Tab and enter the username. 

 Click Modify > User Classes. 

 Click the BAN_AIPADMIN_C class, and select Yes for User in Class. 

 Close that tab and click Banner Rules.  

 Enter the Primary Banner ID for the Oracle user account and save. 

Steps to Configure Banner 9 Self-Service applications to integrate 
with Application Navigator 

Banner 9.x Self Service (SSB9x) applications can be configured to integrate with Application Navigator 
2.0 (or higher). When configured, a menu item will appear in the Application Navigator menu for each 
Self Service Application. Once a Self Service application is integrated it will also 
be included in the search results displayed in Application Navigator. 

Notes:  

The URL must match exactly what is in the applicationNavigator_configuration.groovy file. The Link 
Text is required and if left blank users may not be able to login and display AppNav correctly. 
Users have access to the Menu item in AppNav based on webtailor role assigned to the SSB display 
menu. 
 

Review Ellucian Articles # 000037011, 000037022 and the Application Navigator Handbook for 
additional details. 
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Review Action Item Processing Templates 

Ellucian delivers a set of sample Page Builder templates that can be used to create action items. 
Customize these templates or use them as samples for building templates specific to the institution. 

For more information, review the Banner General Self-Service Handbook. 

Review Status Values 

If there is a Review Status the institution does not want to use, update the Active Indicator to N for the 
row in the GTVRVST table. 

The system displays the Review Status names to both to reviewers and the users. Updating the Name 
field to the desired name for the row in the GCRRVST table will change the display. 

For information detailing the interaction of the review status flags, refer to the “Interactions of various 
flags” section of the Banner General Self-Service Handbook. 

 Review Status Validation (GTVRVST) table 

 Review Status Default (GCRRVSD) table 

 Review Status Information (GCRRVST) table 

Configure Institution-level settings to enable attachments 

 Enter the maximum file size through the value in aip.allowed.attachment.max.size. This 
should be a single value that specifies the number of bytes for the file size. Files that 
exceed this size will not be allowed. This has a default of 1 kb. 

 Enter a value for the maximum number of attachments in the 
aip.institution.maximum.attachment.number. This value has a default of 10, but users 
can enter any single value. Action Items can contain fewer attachments, but an Action 
Item with a greater number will not be allowed. 

 Indicate the restricted file types through the aip.restricted.attachment.type. The format is 
[extension, extension, … extension] the “.” is not necessary when providing the 
extension, and case is not significant. Enclose each extension in single quotations. Files 
with one of these extensions will not be allowed. This can accommodate multiple values, 
but .exe files are not allowed, even if this literal is not included in the configuration. 
Example entry: ['EXE', 'json', 'XML']. 

 Indicate where the files are being stored in the aip.attachment.file.storage.location. This 
should be a single value. 

 If the value is AIP, the file will be stored as a BLOB in the GENERAL.GCRAFCT table. 

 If the value is BDM, the file will be stored in the Banner Document Management 
application. 

 When a user initiates an upload, the attachment will be stored in the facility that is 
currently enabled. The attachment will always be retrieved from where it has been stored 
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regardless of the current configuration; this is for both review and delete actions. As a 
consequence, it is possible that if a response has multiple attachments, these could be 
stored in different locations. 

Configure BDM to enable attachments 

 If the institution will be storing documents in Banner Document Manager (BDM), BDM 
needs to be configured. Even though these configurations are duplicates of AIP 
configurations, they are mandatory when using BDM for attachments. 

o Indicate the file types not allowed. 

o Indicate the file size maximum.  

Note: The maximum file size in the BDM configuration should be equal to the maximum 
file size specified in the AIP configuration. 
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Configure Web Tailor menus for Action Item Processing 

Configure the main menus 

Perform the following actions to configure the main menus – Action Items and My Action Items. 

Procedure 

 Log in to the Web Tailor application. 

 Click Menu Items. 

 The Select Menu Items to customize page appears. 

 In the Search by Name field, enter bmenu.P_MainMnu. 

 Click Search. 

 Result: Based on the search parameter, the procedure name displays in the list. 

 Select the procedure name bmenu.P_MainMnu from the list. 

 Click Add a New Menu Items. 

 On the Create a new Menu Item page, configure the following for the Action Items menu 
item: 

o URL field = bmenu.P_AipMainMnu 

o Link Text = Action Items 

o Link Description = Action Items 

o Status Bar Text = Action Items 

o Enable the Submenu Indicator check box. 

 Configure the following for My Action Items menu item: 

o URL field = AIP listing page URL 

o Link Text = My Action Items 

o Link Description = My Action Items 

o Status Bar Text = My Action Items 

Result: Menu items display and you can click the menu items for more actions. 
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Configure the sub menus 

Perform the following actions to configure the sub menus – Maintain Action 

Items and Monitor Action Items. 

Procedure 

 Log in to the Web Tailor application. 

 Click Menu Items. 

 The Select Menu Items to customize page appears. 

 In the Search by Name field, enter bmenu.P_AipMainMnu. 

 Click Search. 

 Result: Based on the search parameter, the procedure name displays in the list. 

 Select the procedure name bmenu.P_AipMainMnu from the list. 

 Click Add a New Menu Items. 

 On the Create a new Menu Item page, configure the following for the Maintain Action 
Items menu item: 

http://yourschool.com/BannerGeneralSsb/ssb/aipAdmin 
 

o Link Text = Maintain Action Items 

o Link Description = Maintain Action Items 

o Status Bar Text = Maintain Action Items 

 Configure the following for the Monitor Action Items menu item: 

o URL field = A fully qualified URL, for example, 

http://yourschool.com/BannerGeneralSsb/ssb/aipReview 
 

o Link Text = Monitor Action Items 

o Link Description = Monitor Action Items 

o Status Bar Text = Monitor Action Items 

 

Review Web Tailor User Guide for further details. 
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Functional User Setup 

Enable Action Item Processing 

 Access the Integration Configuration Settings (GORICCR) page. Use the 
GENERAL_SSB process and select one of the following options for the 
ENABLE.ACTION.ITEMS setting:  

o Option Y = Action Item Processing is enabled. The Administrative Pages are available to 
set up Action Item Processing. Assigned Action Items are available from the General 
Self-Service landing page. Any halting Action Items prevent a user from proceeding to 
the associated process. 
 

o Option N = Action Item Processing is disabled. The Administrative Pages are not 
available to set up Action Item Processing. Any previously assigned Action Items are not 
available from the General Self-Service landing page. Any halting Action Items do not 
prevent a user from proceeding to the associated process. 

Review Contact List using Access Banner Applications 
Configurations (GUACONF) 

 Verify the Application ID: GENERAL_SS exists 

o On the Configurations tab, verify Configuration name = 
BANNER_AIP_REVIEWER_CONTACT_INFORMATION and Configuration Type = 
arraylist 

 Add school information in the Configuration Value = School Name, Address, 
email 

o On the Configurations tab, verify GENERALLOCATION exists, Configuration Type = 
string, and Configuration Value = http://<HOST_NAME><PORT>/BannerGeneralSsB/  

o On the Configurations tab, verify BCMLOCATION exists, Configuration Type = string, 
and Configuration Value = http://<HOST_NAME><PORT>/CommunicationManagement/   

 Verify Application ID: StuRegSS exists 

o On the Configurations tab, verify GENERALLOCATION exists, Configuration Type = 
string, and Configuration Value = http://<HOST_NAME><PORT>/BannerGeneralSsB  
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Communication Management 

Create folders 

Access Banner General Self-Service > Action Item Administration > Manage Folders, Populations and 
Queries to access the Communication Management landing page > Folders. 

Create and generate populations 

Access Banner General Self-Service > Action Item Administration > Manage Folders, Populations and 
Queries to access the Communication Management landing page > Populations. 

Create and publish queries 

Access Banner General Self-Service > Action Item Administration > Manage Folders, Populations and 
Queries to access the Communication Management landing page > Queries.  

Review Banner Communication Management Handbook for further details 
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Action Item Administration 

Create Status Codes 

 Access Banner General Self-Service > Action Item Administration > Action Item Status. 
Click Add. In the Add Action Item Status window, enter the name of the new Action Item 
Status Code. 

 Select the Halt Process check box if the users want the Status Code to prevent a user 
from accessing any associated processes. Users can now associate this Status Code 
with an Action Item.  

o Status Codes control whether or not the user can continue with any associated 
processing, so users will want multiple types of Status Codes for different situations at 
the institution.  

o Ellucian supplies three Status Codes: Pending, Completed, and Rejected. Each of these 
reflect different types of responses and if the user can continue with the associated 
processing. The institution may want to create Status Codes that facilitate a negative 
response and a halting behavior. 

Create Action Items 

 Access Banner General Self-Service > Action Item Administration > Action Items. Click 
Add. In the Name field, enter the name a unique name for the Action Item. 

 In the Folder field, enter the name of the folder where this action item should be added. 
Use folders to organize Action Items. 

 Select the Status of the Action Item. 

o Draft 

o Active 

o Inactive 

 In the Action Item Title field, enter a title that users see when they view the list of their 
Action Items. Use the Description field to describe the purpose of the Action Item. 

 After users save the Action Item, the users are presented with the Overview page. This 
displays the Action Item information entered. Click Edit to change any of that 
information. 

Create an Action Item that allows an attachment 

 After the institution has decided to allow attachments and has done the institution-wide 
configuration, an AIP administrator can begin creating Action Items that allow 
attachments. 
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Edit Action Item content 

 Access Banner General Self-Service > Action Item Administration > Action Items. Click 
the Open icon in the Actions column to open the Action Item to edit. 

 Select the Action Item Content tab, and click Edit. 

 Select a Template. 

o The template controls how the Action Item will be displayed using a predetermined 
format. Warning! If users make changes to any of the delivered templates, the 
corresponding posted Action Items may not display correctly to users. 

 Add the content for the message associated with the Action Item. 

o The text editor supports rich text markup and links to external pages. Users can use 
links for actions such as completing an online survey or updating personal information. 
Of the supplied templates, only the Master Template and the Master Template for 
upload will display any entered content. 

 Create the responses users want to use and the information associated with each 
response. 

 To create new responses, click Add Response Option. Select the Status Code 
associated with each response. 

o If the response should initiate a review, select the Need Review check box. 

o To allow users to include attachments as part of the response, select the maximum 
number of attachments. This will be capped by the institution maximum number. 

o Select the order in which the user wants the responses displayed by using the up and 
down arrows associated with the response. Note: Ellucian is not maintaining a history of 
the content of the Action Item. However, Ellucian does allow institutions to see what the 
person read before responding. 

View the Open Action Item page 

There are three tabs on the Open Action Item Page: Overview, Halted Processes, and Action Item 
Content. Review and edit these three tabs before posting the Action Item. 

Action Item Groups 

 Access Banner General Self-Service > Action Item Administration > Groups. Click Add 
to add a new Group. 

 In the Name field, enter the name a unique name for the Action Item. 

 In the Folder field, enter the name of the folder to add this Action Item to. Use folders to 
organize the Action Items. 

 Select the Status of the Group. 
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o Draft 

o Active 

o Inactive 

 In the Action Item Title field, enter a title that users see when they view the list of their 
Action Items. 

 Use the Description field to describe the purpose of the Action Item. 

 After saving the Group, users are presented with the Overview page. This displays the 
Group information entered. Click Edit to change any of that information. 

Edit Groups to add Action Items 

 Access Banner General Self-Service > Action Item Administration > Groups. Click the 
Open icon in the Actions column to open the Group to be edited. 

 Select the Group Action Items tab and click Edit. 

 Click Add Action Item to select the Action Items to be put into the Group. 

o Action Items are organized by folders. Only the folders the user has access to are 
displayed here. After adding an Action Item to the group, it is no longer displayed in the 
list. Remove an Action Item by clicking the Delete icon. 

 Select the order in which the Action Items should be displayed in the group by using the 
up and down arrows associated with the Action Item. 

 After saving the entry, the Group is available to post. Note: Because users will have the 
opportunity to refine the list of Action Items later in the process, use fewer larger groups 
rather than many smaller groups. This is an institutional decision. 

Post Action Items 

 Access Banner General Self-Service > Action Item Administration > Post Action Items. 
Click Add to add a new Job. 

 In the Posting Job Name field, enter a unique name for the job posting. 

 Select the Group that has the Action Items to be posted. 

 Select all Action Items in the group, or select a subset of Action Items from the group. 

 Select a Population Name. 

 To regenerate the population right before posting, select the Regenerate Population 
prior to posting check box.  

Note: If a SQL statement is used in BCM to define the population, Banner evaluates the 
Regenerate Population prior to posting check box setting at the time the posting job is 
initiated. If no SQL statement is used in BCM to define the population, Banner will 
always use the most recent version of the population. 
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 Decide when to post the job. 

o Post Now 

o Schedule Date and Time 

o Recurring Posting 

 For the Post Now and One Time Posting options in the Display Start Date and Display 
End Date fields, enter the dates recipients should see the Action Items. These dates can 
be different from the run dates, and they control when a process will be halted by an 
Action Item. 

 For the Recurring Posting option, the display range is not fixed as it is for the other 
posting options. Instead, the range is relative to when a particular posting job is run: 

 Display Start Date 

o This will be specified as an offset from the day the posting job runs. 

o The Display Start Date will be calculated for each job in the recurring set. 

 Display End Date 

o This could be either an offset from the day the posting job runs or it could be a fixed 
date. If the former, the Display End Date will be calculated for each job in the recurring 
set. 

o The Display End Date must be after the Display Start Date and after the actual run date. 

 There is a time period check for any overlap in Display Dates, and it is not limited to the 
exact same start/end days. Be aware that the time period assigned by the first of these 
jobs will be the one that the person will be subject to. 

 For the Recurring Posting option, users will also need to enter the frequency of the 
posting in the Recur Every area. Specify two parts, the Frequency and the Time Unit. 
For example, every two days or every eight hours. 

 For the Schedule Date and Time and the Recurring Posting options, enter the Date, 
Time and Time zone needed to run the job. In the case of the Recurring Posting, this will 
be when the first job of the set will be scheduled. Users can edit selected fields of a 
recurring job if it is before all the jobs have run. Only jobs that have not yet run will be 
impacted by any change. 

 Job Status should state Complete. 

View recurring jobs detail 

 Users will see the recurring job information in the Post Action Item page with a Job 
Status that identifies it as a recurrence. From there, access the Recurring Jobs detail 
page by selecting the More icon in the Recurrence column. This page is view only.  

Note: Only edit the settings for the entire set of recurring jobs. Individual job within the 
set cannot be edited. 
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Assigning more than one Action Item to a person 

 Only assign an Action Item to a person one time during a time period. If a person is assigned to 
an Action Item and a subsequent job runs to assign this same Action Item to this person, the job 
skips processing this person/Action Item combination. This is not considered to be an error. 

 

Review responses to an Action Item before they are approved 

 Monitor Action Item page 

o Reviewers can use the Monitor Action Item page to see the status of all Action Items in 
process. This page also displays the review status of an Action Item, if it requires review, 
and it displays an icon next to an Action Item if there are attachments.  

 Action Item Review page 

o Item Review page, the AIP reviewer can see more information about the Action Item, the 
chosen response, and the review. If attachments have been uploaded, the count will be 
provided along with the paperclip icon, enabling the reviewer to view the attachments. 

 

 

Review General Self-Service Handbook for further details. 
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Testing and Verification 

Login and Test AIP 

 Login as student. 

 Click Continue. 

 Click on View Action Items. 

 Click on the Action Item title. 

 Perform the action required by the Action Item.   

Student User Experience 

 Basic Action Items: After users have been assigned Action Items, they can review and 
process their action items from their Action Item list in General Self-Service. 

 Halted processes: Once the students have cleared the halted process, they may move 
on with other functions in Banner Self-Service. 

 Review: An Action Process that returns a YES response. 

 Review with attachments: Review an Action Item that has an attachment with the 
response. 

Responding to an Action Item response that allows attachments 

 Click the paper clip icon. A pop-up window appears. 

 Click Browse. Select the file. 

 Select Upload to initiate the upload. When the upload is initiated, it will proceed even if 
the pop-up window is closed. 

 Repeat as necessary to the specified maximum number of attachments. Users can 
review and delete the uploaded attachments. When users are satisfied with the 
attachments, close the pop-up and return to the Action Item List page. At this point, the 
response should be saved. 
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